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INTRODUCTION

How SMC works
HOW SMC WORKS

SurfControl’s Single Management Console (SMC) enables you to manage all of 
the SurfControl servers within your organization from a single computer, 
regardless of where your SurfControl products are located, nationally or 
internationally. With SMC you can: 

• Start and stop services on each server. 

• Run reports. 

• Administer the components that are included in a product.

• Instantly check the status of your SurfControl products across your network. 

WORKING WITH SMC
SMC provides you with an interface in which you can build a view of your whole 
enterprise. Items are added one by one to a tree-like structure which you design 
to represent your enterprise, either by offices with their relating servers or by 
SurfControl products with each server listed. The following shows an enterprise 
created to show each office, its location, then the sites with their corresponding 
servers and their applications. The view has been customized using color and 
icon options to make it more meaningful for the administrator:

There are two ways that you can use the SMC:

• Create a new enterprise view - construct a brand new enterprise view within 
the SMC by adding locations and servers. This can then be saved to a 
configuration file which can be just saved locally on the machine or shared 
with other administrators. This enterprise view can then be viewed as an 
organization or based on products.

• Open a previously configured file - open a previously created file or one 
shared by an Administrator. See ‘“Sharing files” on page 31 for information 
on sharing files.
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CONFIGURATION

Getting Started
GETTING STARTED 
Install the Single Management Console by navigating to where you downloaded 
your SurfControl product to, then double-click the Single Management Console 
setup.exe. Alternatively run the installation from your product CD. 

When you first open SMC you will need to create a view of your enterprise. This 
view will then be saved to a configuration file and used by SMC to build a view 
of your enterprise whenever it is opened. This file could also be shared so that 
another user can view it and administer SurfControl products via their SMC 
installation.

OPENING A PREVIOUSLY CONFIGURED FILE
When you open the SMC it always opens the last file that you viewed. If you are 
opening the SMC for the first time there will be no previous configuration file 
loaded so it will ask you which configuration file you wish it to show. It will also 
give you the option to create a brand new configuration file: 

There are two options to choose from:

• Create a new configuration - choosing this option will show a blank pane 
followed by a dialog where you can add a server (see “Product view” on 
page 13 for more information on adding servers) and start to create your 
enterprise.

• Use an existing or shared configuration file - if you have already created a 
configuration file or are opening a shared file then you can either enter the 
path to this file or click the Browse button  to navigate to it.
SurfControl Single Management Console 2.0 Administrator’s Guide 7
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Menus within SMC
MENUS WITHIN SMC
The menus at the top of the SMC give you access to a number or actions:

FILE MENU
The File menu is the main point of access to your configuration files. It contains 
a number of options:

Note: Some of these 
tasks can only be 
performed if the 
configuration file is 

open in Admin mode.

• New - closes the current configuration file and opens a blank view in Admin 
mode ready for the addition of new servers and/or organization details. This 
view can then be saved to a new configuration file.

• Open... - opens a Select Configuration File dialog where you can select a 
previously created configuration file.

• Close - unloads the configuration file and clears the tree view. You now need 
to select New or Open... in order to create or select a new configuration file.

• Save - saves the current configuration file.

• Save As... - prompts for file name before saving, enabling you to either 
overwrite an existing file or create a new one.

• Recent... - shows a history of the last five configuration files that have been 
loaded.

• Exit - closes the SMC allowing you to save your configuration if it has been 
altered.

• Properties... - launches a dialog which gives details about the configuration 
file that you are currently using and if the file is locked, who has opened the 
SMC in Admin mode. It also enables you to add your own message to the 
‘Configuration file locked’ dialog and set a password for Admin mode. If the 
file is not locked it can be switched to Admin mode from this dialog.

VIEW MENU
The View menu enables you make sure that the enterprise view that you are 
seeing is the most up-to-date one:

• Refresh - checks the server status then reloads the configuration file. If the 
file is shared then you will see any recent changes made by other 
administrators. 
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Menus within SMC
ACTIONS MENU
The Actions menu is where you configure the view of your enterprise by adding/
removing sites and servers and re-setting the icons that represent them. The 
items within this menu depend on what is selected in the SMC. If the root of the 
console tree is selected then this menu is grayed out.

Note: The Action 
menu changes as 
you select different 
items in the console 

tree. These menu items are also 
available if you right-click on 
the item in question.

Product selected:
• Add... - enables you to add SurfControl products so that you can configure 

them from SMC.

• Set Icon... - enables you to modify the icon for the product. If you add 
regions or sites etc. to your organizational view you will be able to specify an 
icon for each of these. You will be unable to change anything with 
SurfControl branding.

Server selected:
• Rename - enables you to change the names of servers. 

• Remove - enables you to remove the selected item or branch of the tree. You 
cannot remove individual applications from the server. However if an 
application is not available you can hide them by selecting ‘Hide unavailable 
applications’ from the General tab of the Options dialog. 

• Properties... - this enables you to see details of a server, its machine name, 
service status, product type and version.

• Configure Applications... - some applications require further configuration 
once you have added them to the SMC. This menu item enables you to 
configure any applications that need it without having to choose each one 
separately.

Applications selected:
• Open - open the selected application.

• Configure - if the application needs configuration this menu item will be 
available when you select the application.

Services selected:
• Start - start the selected application.

• Stop - stop the application. 
SurfControl Single Management Console 2.0 Administrator’s Guide 9
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Menus within SMC
TOOLS MENU
The Tools menu enables you to modify the look and feel of the SMC tree view:

• Set Icon Presets... - enables you to modify your default icons. 

• Options... - launches a dialog where you can set the server refresh rate, set 
colors to represent the status of items in the tree, change the tree view and 
set the colors of the tree.

ADMIN MENU
The Admin menu enables you to edit the SMC view and thus the configuration 
file: 

• Admin Mode - switches Admin mode ‘on’ or ‘off ’. Admin Mode enables 
you to modify the enterprise view.

HELP MENU
• Help Topics - launches the SMC online help system.

• About SMC - launches a dialog containing version information.
10 Administrator’s Guide SurfControl Single Management Console 2.0
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VIEWS WITHIN SMC
There are two ways in which you can use SMC to view and configure your 
enterprise: Organization and Product view. Either can be seen in the SMC by 
choosing it from the Select view list.

ORGANIZATION VIEW
The Organization view enables you to set up the view so that you can see your 
enterprise in relation to where the servers are located:

For example if your enterprise is split between a number of offices then you 
could arrange the view so that you have a list of offices under the SMC node. 
Each of these offices could then have each server room and its servers listed. 
These would then reflect all of the SurfControl products installed with a list of 
client applications under each one.
SurfControl Single Management Console 2.0 Administrator’s Guide 11
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Procedure  1: Creat ing  an  Organ iza t iona l  v iew
Step Action

1 Select Organization from the Select view list.

2 Ensure that Admin mode is selected in the Admin menu.

3 Right-click on the SMC root item in the tree and select Add... from the 
pop-up menu. A drop-down menu will appear:

4 Choose the type of item that you want to add:

• Organization - the name of the company or organization that this information belongs to (this 
could represent different companies if your enterprise consists of these). 

• Region - the state/city/town where the organization’s office is located. This could also be listed 
as the region, such as NW for example.

• Location - the office name of this part of the company or the city/town.

• Site - this could be the office name or even the actual room where the server is located within 
this office.

• Server - the actual name of the server that the product(s) is/are located on.

5 Once you have chosen the type of item that you want to add it will appear in the console tree with 
the title in a format that is immediately ready to edit. You can also set an icon to represent it by right-
clicking on the item and choosing ‘Set Icon...’

6 If you want to add a server to the item then right-click on it and select Add... This will show the Add 
Server dialog to enable you to add this server to your enterprise view. Details of adding servers are 
contained in the next section, ‘Product view’, though you can add servers in the Organization view as 
well.
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Views within SMC
PRODUCT VIEW
Products view enables you to see machines grouped according to the products 
that they are running. The first layer of this hierarchy is the product name, in this 
case SurfControl Web Filter. This is then followed by the names of servers with 
this product installed and their attendant applications. It is a much simpler view 
than the Organizational view, enabling you to concentrate on just the 
SurfControl products followed by a list of what servers they are installed on:

You can reflect a view of your enterprise view in either the organization or the 
Product views. With Organization view you can add a variety of items related to 
location, server name etc. to reflect the way that the SurfControl products are 
arranged within your company. With the Product view the tree represents each 
of the SurfControl product types: Web Filter, E-mail Filter etc. with servers listed 
beneath their relevant product.

Procedure  2: Creat ing  a  Products  v iew
Step Action

1 To start with, use the Organizational view to add the servers containing the products that you wish to 
see in your enterprise view. 

2 Select Products from the Select view list and ensure that Admin Mode is selected in the Admin menu.

3 Right-click on the product at the top of the tree and select Add... 
SurfControl Single Management Console 2.0 Administrator’s Guide 13
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Views within SMC
4 A dialog will appear showing all of the versions of products that 
are supported by SMC. For this reason it is important that you 
know the version numbers of any product servers that you wish 
to add to SMC to ensure that they are supported. 

5 Enter the DNS name or IP address of the server that you wish to add (UNC names are not supported) 
and select the check-box next to the server that you want to add.

6 Select the text of the server and click the Test connect... button 
which will now be enabled.

7 You will now see a Test Connect dialog. The message that appears in the server/service status pane will 
establish whether there has been a successful connection between the server and SMC. Details of 
what status messages mean can be found in the Trouble-shooting section, ‘Error Codes’.

8 Click OK to close the Test Connect dialog then click Add...

P rocedure  2 : Creat ing  a  Products  v iew
Step Action
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CONFIGURATION

Views within SMC
9 If the product consists of applications that need configuring, a 
Configure dialog will appear:

10 Select the ‘Enable...’ check-boxes in these dialogs till you reach the last one where you can click Finish.

11 You will now see the new server in the SMC window. 

Procedure  3: Conf igur ing app l icat ions  af te r  add ing  a  server
Step Action

1 Real-Time Monitor and SurfControl Report Central can be configured from the SMC. If you wish to 
configure them right-click on the application that you wish to configure and choose Configure... 
from the pop-up menu.

2 A dialog will appear in which you can edit the server and port number details of this application.

3 Once you have entered the correct details click OK.

Procedure  4: Opening appl i cat ions  with SMC
Step Action

1 Right-click on the application.

2 A drop-down menu will appear with various actions listed on it 
depending on which application it is:

3 If the application needs any configuration there will be a configuration item in the menu. Select the 
action that you require from the menu and a Server dialog will open.

Procedure  2: Creat ing  a  Products  v iew
Step Action
SurfControl Single Management Console 2.0 Administrator’s Guide 15
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Views within SMC
4 Select the ‘Enable’ check-box.

5 Enter the server name and port number.

6 Click OK.

Procedure  4: Opening appl i cat ions  with SMC
Step Action
16 Administrator’s Guide SurfControl Single Management Console 2.0
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Views within SMC
REMOTE SERVICE CONTROL
You can control the SurfControl product services from within the SMC. The 
following picture shows the services that are available within the SMC for 
SurfControl Web Filter

Note: You cannot 
change the icon 
representing any of 
the services.

The SMC shows you the status of each of these services and enables you to start 
or stop each one. 

Procedure  5: Start ing and stopping serv i ces  w ith in  SMC
Step Action

1 Right-click on the service.

2 A drop-down menu will appear. Choose Start or Stop.

3 Alternatively double-click the service that you want to start or 
stop. A Service Control dialog will appear:

4 The only action available will be the one that it is possible to perform. For example, if the service is 
running then you will only be able to select Stop. Select the action to perform and click OK.
SurfControl Single Management Console 2.0 Administrator’s Guide 17
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Views within SMC
SAVING AND VIEWING CHANGES
You can make changes to the tree view of SMC by adding or deleting servers 
and/or changing their arrangement in the hierarchy. You can also change the 
icon alongside every item with the exception of servers and applications. To 
make sure that any changes are reflected in the SMC:

• Click Save or exit the SMC, clicking Save as you do so. If you are viewing the 
SMC in ‘read-only’ mode then you can make sure that you can always see the 
most up-to-date view, including anyone else’s changes if you are using a 
shared file, by choosing Refresh from the View menu. 
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MODIFYING THE SMC VIEW

User modes
USER MODES

Once you have created your first enterprise view and saved it as a configuration 
file, it can be opened at any time within the SMC and edited. By default the last 
configuration file that was opened in the SMC will be shown when the SMC 
opens. There may be times when you want to add, remove or modify servers or 
organization location details or even change the look and feel of the view that 
you already have. There are two modes in the SMC: 

• Admin Mode - this mode enables you to make changes to the enterprise 
view in SMC by adding and deleting servers, changing the look and feel etc. 
You will then be able to save these changes to the configuration file.

• Local Mode - this mode enables you to open a configuration file and look at 
your enterprise and products in the SMC. You will not be able to make any 
changes to the view or alter the configuration file in any way. 

Regardless of what mode you are in, you will always be able to launch any of the 
client applications for each server. The status of servers will also be shown.

When you open the SMC it may have opened in read-only mode. If this is the 
case then in order to edit the view shown by the SMC you will then need to 
switch to Admin mode. To switch to Admin mode: 

• Choose Admin Mode from the Admin menu or use the shortcut keys 
CTRL-D. Now you can edit the SMC view by adding, deleting and/or re-
organizing your servers/products.

If someone else has this file open in Admin mode when you attempt to turn 
Admin mode on, you will see a ‘Configuration file locked ‘message. This is 
because only one person can edit an SMC configuration file at one time. When 
switching to Admin mode a lock file is created. This file contains information 
about the machine that locked the file and it ensures that no other user will be 
able to enter Admin mode while this file is present. 
SurfControl Single Management Console 2.0 Administrator’s Guide 21
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User modes
CHECKING SMC PROPERTIES
You can check the details of your servers by using the Properties dialog. To see 
the Properties dialog right-click on the server that you are interested in and 
choose Properties... from the drop-down menu. This will launch the Properties 
dialog: 

The Properties dialog gives the following information about the server:

• Name - the display name that you gave this server when you added it to the 
enterprise view.

• Type - the product: Web Filter, Web Filter VS, E-mail Filter or Instant 
Messenger.

• Version - the version number of the server.

• Server/service status - the status of all services on the server.

• Machine name - the name of the server where the product is installed. If the 
server is moved to a different machine, the machine name and IP address 
can be updated by in Admin mode. Use Test Connect to validate the 
connection.
22 Administrator’s Guide SurfControl Single Management Console 2.0
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Changing icons
CHANGING ICONS 

CREATING AN ICON FILE 
You can create a more personalized view by adding different icons to each item 
in the view. If you wish to personalize the SMC you can do this in one of three 
ways:

• Create a folder for your own icons and save new icons to this folder. When 
you come to set the icon for a particular tree item you can then choose an 
icon from this folder. 

• Find or create new icons and copy them to your SMC installation directory 
which, by default, would be: 
 
C:\Program Files\Common Files\SurfControl\SMC 
 
Icons can then be loaded from here.

• Use the supplied icons within default_icons(16X16).bmp.  
You will find this within this SMC directory.

The first step in customizing the SMC involves creating your icons in an icon 
editor or creating a bitmap to use as an icon. Alternatively icons can be 
downloaded or supplied by a designer. You can also pick icons from any .exe, 
.bmp .ico or .dll file. For example, the file winamp.exe will yield approximately 10 
icons. If you are going to manually create an icon or have someone create one for 
you, the following specifications are necessary:

• Icon created in an icon editing program - this must be at least 16 X 16 pixels.

• Icon created from a bitmap - this must be a 16 X 16 pixel bitmap in 256 
colors.

Once you have created your icon then it can be saved to a folder anywhere on 
your system that can be navigated to from the Set Icon dialog. For the SMC to be 
able to use it must in one of the following formats: 

• .exe 

• .dll 

• .bmp 

• .ico 
SurfControl Single Management Console 2.0 Administrator’s Guide 23
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Changing icons
SETTING INDIVIDUAL ICONS
In the Organizational view, any node can have its icon changed once it has been 
added. The exception to this is anything to do with the actual server and its 
resident applications. Icons for these cannot be changed. Neither can any icon 
associated with any of the services be changed.  

Procedure  1: Changing ind iv idua l  i cons
Step Action

1 Make sure that you are in Admin mode by selecting Admin Mode from the Admin menu.

2 Right-click on the item that you wish to change the icon for and 
choose Set Icon... A Set Icon dialog will appear:

3 Click the ‘Select icon file’ option and click the browse button .

4 This will show you a Icon File dialog where you can navigate to 
your icon file. You will also see a supplied icon file called 
default_icons(16X16).bmp. Select this file to choose a 
supplied icon. Once you have selected it click OK and the path to 
this file will appear in the ‘Select icon file’ edit field. Now click 
the arrow to the right of the list box and choose your icon: 

5 Click OK. The icon now reflects the icon that you have chosen.
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Changing icons
SETTING SHARED ICONS
If you decide that you wish to use a different icon to the default one for each 
level in your tree but don’t want to use one for each individual item then you can 
use the Icon Presets dialog to do this. Icons chosen in this way will be applied to 
each item in a certain level so for example you could have all of your regions 
reflecting one icon and all your sites reflecting another.  

Procedure  2: Changing shared i cons
Step Action

1 Choose Set Icon Presets... from the Tools menu or click the Show 
presets... button in the Set Icon dialog. You will now see the Icon 
Presets dialog: 

2 Each section in the dialog corresponds to a particular type of item. Icons chosen for the Site item for 
example will be applied to every site that you add to the SMC. Choose the type of SMC item that you 
are assigning the icon to.

3 A certain number of icons are supplied with the product. To choose from one of these select the 
‘Select from pre-set icons’ option then choose an icon from the drop-down list box to the right of this 
option.

4 To choose an icon from your own icon file select the ‘Select icon file’ option then use the browse 
button to navigate to this file. The contents of this file should appear in the list box, alternatively after 
you have navigated to the icon file, select the icon that you wish to add from this file. This icon will 
now appear in the list box edit field.

5 Once you have chosen icons for each type of item in the SMC click Save. The SMC will immediately 
update and reflect all of the icons that you have selected. These changes will be reflected every time 
this configuration file is opened. If you are sharing this file ensure that your icon file is also shared and 
therefore accessible to all users.
SurfControl Single Management Console 2.0 Administrator’s Guide 25
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SMC Options
SMC OPTIONS

The Options dialog enables you to configure the look and feel of the SMC 
enterprise view: 

• Select Options... from the Tools menu to see the Options dialog:  

GENERAL
The General tab enables you to configure what items are shown and how much 
information is included. You can also set the status refresh rate in this tab:

• Server/service status refresh (mins) - this sets how often the SMC checks 
the status of the service(s) on the server to see if there are any occurrences 
such as server errors. If a service stops then the refresh rate enables the 
service to be detected once it is up and running again.

• Show server version - deselect this option to remove the version number 
from alongside that server’s displayed name.

• Show server DNS name/IP address - deselect this option if you don’t wish 
to see the machine name/IP address alongside the item. 

• Highlight unavailable applications - select this option to enable unavailable 
applications to be shown. Click on the colored box to choose a color to 
represent these applications so that they are easily spotted.

• Don’t show unavailable applications - select this option to hide all 
applications that are unavailable. These would include applications where the 
executable cannot be located in the product. If you find that applications are 
listed as unavailable then you will need to re-install the product to which they 
are attached.
26 Administrator’s Guide SurfControl Single Management Console 2.0
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SMC Options
TREE VIEW
The Tree View tab enables you to set different colors for different parts of your 
enterprise view: 

This can be a useful way of seeing at a glance, each item type. 

Procedure  3: Changing the  co lors  of  the  enterpr ise  v iew
Step Action

1 Click the colored box and alongside each item that you want to change the color for. Select a color 
from the color palette that appears. Items that can be configured in this way include:

• Root - choose this to change the color of the SMC root at the very start of your enterprise.

• Location - choose this to change the color of any location items that you have added.

• Server - choose this to change the color of all servers that you have added to the SMC tree view.

• Product - choose this to change the color of the product type in the Product view.

• Applications - some applications need a small amount of configuration before they can be 
managed by the SMC. Use this section to set colors to reflect the status of the applications for 
each product:

- Configured - choose a color to represent applications that have had the necessary 
configuration carried out and are ready for use. 

- Unconfigured - choose a color to represent applications that still have to be configured 
before they can be used.

2 Once you have selected all of your colors click OK to have them applied to your enterprise view.

Note: If the ‘Show status in tree’ check-box has been selected in the Status Updates tab then 
any settings on this tab will override settings in the Tree View tab.
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SMC Options
STATUS UPDATES
The Status Updates tab enables you to set different colors to represent different 
states within the enterprise tree:

• Show status on tree - check this option to set colors to indicate the status of 
the services in your enterprise: unavailable, stopped, errors while running or 
everything fine. 

• Text Color - the color selected in the colored box will be reflected by the 
server names in the SMC view when the status of the server changes to one 
of the listed options.

• Background Color - choose a background color that will surround the text. 
Select the check-box alongside the option that you want to apply this to then 
click the colored box that will now be enabled, to choose a color.

• Flash - set the background of the text to flash when a server has a change in 
status that matches one of the options. You can also turn the flash off by 
choosing ‘No Flash’ or set the server name to flash until you acknowledge it 
by clicking on the text in the SMC.
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USING CONFIGURATION FILES

Sharing files 4
SHARING FILES

As you add items to your enterprise view in the SMC the information is stored in 
a file that you name and save in a location of your choice. 

Note: This file is 
needed by SMC 
during run-time. It 
must NOT be edited 

manually. All changes must be 
made via the SMC interface or 
you may experience unexpected 
results.

As all of the information that is required for the SMC to see and represent your 
enterprise is stored in your configuration file, it is a good idea to store this file in 
a place such as a shared directory/folder. This will make it accessible to anyone 
who needs to use this enterprise view to administer the SurfControl products. 
Make sure that the file itself is shared if you choose to store it in this way.

In the case of a shared file being used, a local copy of the file is made on the 
client machine in the folder where the SMC is run from. By default this will be: 
 
\Program Files\Common Files\SurfControl\SMC  
 
This copy is then used by the SMC for information about your enterprise until 
the user switches to Admin mode. After this point the shared copy will be used 
directly.

LOCKING THE CONFIGURATION FILE
When you open the SMC it automatically opens in Local Mode. In order to edit 
the view shown by the SMC you need to switch to Admin mode. 

To switch to Admin mode choose Admin Mode from the Admin menu or use 
the shortcut keys CTRL-D. If someone else has this file open in Admin mode 
when you try to turn Admin mode on you will see a message telling you that the 
configuration file is locked and you cannot edit the SMC. This is because only 
one person can edit an SMC configuration file at one time. 

If the file is shared then when SMC opens the shared file it loads a copy of the 
file onto the client ready for editing and the original in the shared folder is 
locked. At the same time a lock file is created. This file contains information 
about the machine that locked the file and it ensures that no other user will be 
able to enter Admin mode while viewing this file.
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Sharing files4
 

SECURING THE CONFIGURATION FILE
You may feel that you need to password protect the editing of configuration files. 
In this way you can be sure that the only people able to make changes to the 
SMC enterprise view are those with permission to do so. 

Procedure  1: Customiz ing  the  ‘Conf igurat ion f i l e  locked ’  message
Step Action

1 You can add your own text to this message box by editing the SMC Properties dialog. First ensure 
that you are in Admin mode.

2 Choose Properties... from the File menu.

3 Select the ‘Admin Mode’ check-box and enter a 
message into the ‘Message to display when file is 
locked’ edit field:

4 Click OK.

Procedure  2: Sett ing a  password for  Admin mode
Step Action

1 Select the ‘Admin Mode’ check-box.

2 Click the Set/Change Password button.

3 In the dialog that follows enter your password and confirm it. This will either add a new password 
or change the one that you have already set.

4 Click OK. Now, whenever anyone tries to switch to Admin mode, they will be asked for a password. 
If you want to remove password protection simply click the Set/Change password button and 
then leave the edit fields in the dialog blank. Clicking OK will remove the password.

Note: You can only change the password when in Admin mode
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TROUBLESHOOTING

Error Codes
ERROR CODES

If the SMC tries to connect to the server and fails you will see an error message. 
You may also see one of these if you click the Test Connect button and the SMC 
cannot establish a connection. The error messages that you may see are listed 
below with a description of what they mean and advice on how to solve the 
problem:

Table 1 Error Codes and Descriptions

Message Description What to do

No SMC 
Interface 
library 
available.

The SMC Interface library either did not 
load or was unavailable.

There is something wrong with the SMCInt.dll 
which is most likely due to an error during 
installation. This could have resulted in the file 
being renamed, corrupted or deleted. You need 
to re-install the server’s Remote Administrator 
for that product in order to re-install the SMC.

No services 
found.

Could not find any services. The SMC has tried to retrieve the list of services 
running on the server that it has contacted and 
has failed to do this. Check that the server that 
SMC is trying to contact has all services running.

Could not 
connect to 
server.

Failed to connect to product server. Check that the DNS/IP address of the server is 
correct and the product is actually on the server 
and running. If this is the case and you are still 
getting error messages, check that your 
network is working properly and that you can 
connect to the machine by performing a ‘ping’ 
test on the server and the client.

To do this open a command prompt by either 
choosing Programs  Accessories  
Command Prompt from the Windows Start 
menu or by typing cmd into the Run dialog.

Next type ‘Ping’ followed by the IP address of 
the machine that you are trying to connect to. 
For example;

H:\ping 172.271.172.3 

All services 
error.

All available services are in an error 
state. These services are then listed.

Check the suspect services on the server.

One or more 
service error.

One or more (but not all) services are in 
an error state. This is followed by a list 
of the services with an indication of 
each one’s status.

Check the suspect services on the server.

All services 
stopped.

All services have stopped. This is then 
followed by a list of these services.

If the services should be running, restart them 
from the server. 

One or more 
services error.

One or more (but not all) services have 
stopped. This is then followed by a list 
of these services with an indication of 
each one’s status.

If the services should be running, restart them 
from the server.
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CHECKING YOUR CONFIGURATION FILE
If you need to check any of the details relating to the properties of your 
configuration file then this can be done via the SMC - File Properties dialog. 
To see this dialog choose Properties... from the File menu. In the dialog you will 
see details of:

• File path and name - the location of the configuration file that you are using.

• Created - the date that it was created.

• Last modified - the last time it was changed in any way.

• Current status - whether the file is being used. If the file is locked then it will 
show as a message stating something similar to: ‘File in use, locked: [Day], 
[Monthly_Day Month], [Year], [Time - Locked_By]’ where:

– [Day] =  the day the file was locked

– [Monthly_Day Month] = Numerical day of the month

– [Year] = the year the file was locked

– [Time - Locked_By] = The time the file was locked and who locked it  
An example could be:  
‘Wednesday, 21 July, 2004, 10:10 - workgroup\cowork13.’

You can also use this dialog to add your own message to the ‘Configuration file 
locked’ message box and set/change a password for the configuration file. See 
“Locking the configuration file” on page 31 for more details.

Server not 
available.

Server is unavailable. Different from ‘No 
response’ and ‘Could not connect to 
server’ in that this returns the results 
from a simple ‘ping’ type request to see 
if the machine can be connected to.

Check that the machine details are correct and 
that the server can be seen on the network. If 
this is the case then check that the machine 
itself is not experiencing problems.

No response. Test command was issued to the 
product server and the ‘No response’ 
was received (request timed out).

Check that the DNS/IP address of the server is 
correct and the product is actually on the server 
and running. If this is the case and you are still 
getting error messages, check that your 
network is working properly and that you can 
connect to the machine by performing a ‘ping’ 
test as explained above. 

Critical error. A critical error occurred. Retry the operation. How you respond to this 
will depend on the operation that failed.

Table 1 Error Codes and Descriptions

Message Description What to do
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